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Readme File for IBM TRIRIGA 10.8.01 Fix Pack 
This fix pack updates the IBM® TRIRIGA® product.  

These release notes include the following: 

• An overview of changes 

• Many of the descriptions include an internal reference number (Tri-nnnnnn, IJnnnnn, IVnnnnn, 
and/or RFE-nnnnnn) 

 
Note – The IBM TRIRIGA wiki information, formerly located on DeveloperWorks, is migrated to 
IBM Docs for IBM TRIRIGA Application Platform 3.8. For more information, see the IBM TRIRIGA 
Release Information page on IBM Support. 

https://www.ibm.com/docs/en/tap/3.8
https://www.ibm.com/support/pages/node/1284928
https://www.ibm.com/support/pages/node/1284928
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What’s New in This Release 
IBM TRIRIGA 10.8.0.1 continues to add valuable functionality, fix defects, and reduce the effort necessary 
for new and existing customers to implement our products. 

Prerequisites and Supported Products 
To install this fix pack, you must have IBM TRIRIGA 10.8.0 installed. 

Installing the IBM TRIRIGA 10.8.0.1 Object Migration 
Package 
You must install the IBM TRIRIGA 10.8.0.1 object migration package on an existing TRIRIGA 10.8.0 
installation. You must have IBM TRIRIGA Application Platform 3.8.0.1 or later installed. 

 
Caution – The fix pack will overwrite existing objects and any customizations made to 
those objects. Review the list of objects by using the Object Migration tool before you 
import the package. 

 

Procedure 

Follow these steps to apply the fix pack: 

1. Extract the OM package ZIP file. 
2. In the Administrator Console, ensure the Object Migration Agent and the Object Publish Agent are 

running. 
3. Log in to TRIRIGA as an administrator.  
4. Go to Tools > Object Migration.  
5. Click New Import Package.  
6. Browse for the OM package ZIP file extracted in Step 1 and click OK.  
7. Use the Validate action to verify that the objects can be imported successfully.  
8. Use the Import action to initiate the import process. A notification is sent to the user when 

the import process is complete. 

 

What to do next 

After the import process is complete, log in to TRIRIGA and check the application version by clicking the 
information icon in the upper-right corner of the TRIRIGA window. 
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IBM TRIRIGA 10.8.0.1 Patch Helper Workflows 
Patch helper workflows correct the record data in your IBM TRIRIGA Application. A patch helper workflow 
can revise and update, bring new data records for a release, and recalculate records. The patch helper 
makes necessary changes to your IBM TRIRIGA database. You apply the patch helper workflows for a release 
after you install or upgrade to that release. Wait for one patch helper workflow to complete before you 
begin the next. Some patch helper workflows can take a long time to complete. 

Note: Many of the patch helpers included in this release have already been included in earlier fix packs, as 
shown in the patch helper name. When you run the main 10.8.0.1 patch helper workflow, it determines 
which of the other patch helper workflows have already been applied and does not re-run any that are 
already applied to your system. 

The following patch helper workflows are in this release: 

Name Description 

triPatchHelper - Synchronous - 10.8.0.1 - 
Main Patch Helper 

The 10.8.0.1 patch helper workflows will be triggered 
automatically after the 10.8.0.1 OM package is finished 
importing. 

triPatchHelper - triCalculate – 10.8.0.1 - 
Application Data - App Version 

This patch helper updates the application version record with 
the upgraded date if an application version exists, otherwise, 
it creates an application version record.  

triPatchHelper - triCalculate - 10.8.0.1 - 
Hide Attention Message from Facilities 
Projects 

This patch helper workflow hides attention message for 
completed facility projects. 

triPatchHelper - triCalculate - 10.8.0.1 - 
Remove Additional Contract Attribute 

This patch helper workflow removes additional contract 
attribute records associated with leases. 

triPatchHelper - triCalculate - 10.8.0.1 - 
Retire Building System Items 

This patch helper retires building system item records 
associated to retired buildings. 

triPatchHelper - triCalculate - 10.8.0.1 - 
Update Primary Location of Work Task 

This patch helper updates task primary location where 
location path is invalid.  

triPatchHelper - triCalculate - 10.8.0.1 - 
Update Primary Location of Asset 

This patch helper updates asset's primary location where the 
location path is invalid. 
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IBM TRIRIGA 10.8.0.1 Enhancements 
The following enhancements are included in the IBM TRIRIGA 10.8.0.1 fix pack. 

Area of Impact Description 

Facilities Projects A new field, 'Responsible Role', has been added to the Task record under the 
General tab > Responsible Person section. This field can be selected manually 
while creating the record. 
 
In the Capital/Facilities Project record > Schedule tab > Project Tasks section, if 
you click the ‘Assign Task by Role’ section action, the system will pick the 
Responsible Role from the General tab of the selected Task record and find the 
corresponding responsible person from the matching contact role of the 
Capital/Facilities project. The details of the responsible person retrieved will be 
mapped to the General tab of the Task record > Responsible Person section. 
 
For example, for the Building Condition Manager Contact role of a Facilities 
Project, Person A is assigned as a Contact. 
 
Now, a Work Task record is created from the Facilities Project > Schedule tab > 
Project Tasks section. On this Work Task record, on the General tab, in the 
Responsible Person section, the Building Condition Manager Contact role is 
selected as a Responsible Role. 
 
Next, if the ‘Assign Task by Role’ section action in the Facilities Project record > 
Schedule tab > Project Tasks section is clicked; then, Person A will be mapped to 
the General tab of Task Record > Responsible Person section.  

(Tri-68081-IJ26402) 

Lease - Asset and Real 
Estate 

The Total Rent Expenses fields in the Schedule Summary section (on the 
Accounting tab) and the Amortization Summary section (on the Local Reporting 
tab) now include the Dismantle Cost for an IFRS lease. (Tri-87730) 

Lease - Asset and Real 
Estate 

The Gain/Loss column in Accounting Schedules follows the same sign convention 
in all the scenarios. If it’s a loss, it displays a positive (+) amount in the Gain/Loss 
column. If it’s a gain, it displays a negative (-) amount in the Gain/Loss column. 
(Tri-82274-IJ32130) 

Lease - Asset and Real 
Estate 

On the Calculation Inputs tab, a new column 'Nth Period From Cumulative From 
Period' is added to the Lease Journal Entry Setup form. This helps in selecting the 
Nth Period from the Cumulative From period in the calculations. (Tri-82267) 

Lease - Asset and Real 
Estate 

A new Period 'Original Accounting Start Period' is added to the Calculation Period 
list of Journal Entry Calculation Input. (Tri-67971) 

Reserve Perceptive 
App 

On an iPhone with the VoiceOver feature enabled, after swiping right from the 
"My Reservations" button, the focus will move to the next item and announce the 
"dimmed” button (disabled navigate to the previous page of reservations button) 
instead of the "New Reservation" button. (Tri-88487-IJ36460) 
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IBM TRIRIGA 10.8.0.1 Known Limitations 
The following known limitation is included in the IBM TRIRIGA 10.8.0.1 fix pack. 

Area of Impact Description 

Reserve If you cancel a reservation from Microsoft Outlook, you might get an additional 
notification. The notification can be ignored, and no action is required.  
(Tri-89193) 

Work Planner 
Perceptive App 

All the tiers of the location path will be shown in the work task.  
(Tri 84293-IJ40203). 

Workplace Services 
Perceptive App 

On iOS, when VoiceOver is turned ON, opening the search location page while 
creating a new reservation announces the fields on the previous page. It briefly 
goes to an invisible element but snaps back to the upper-left corner to the back 
button. 
(Tri-88488-IJ36466) 

IBM TRIRIGA 10.8.0.1 Changes 
The following changes are included in the IBM TRIRIGA 10.8.0.1 fix pack. 
 

Area of Change Description 

Approvals The approval process for the "Process Payments" BO has been updated. The 
system will now consider the sum of "Expected Amount with tax" from the 
associated Payment line items as the Approval amount.  
The following updates were made: 

• Updated the workflow: triProcessPayments - triIssue - Submit for 
Approval and Dependent Record Update. 

• Added Retrieve task to get sum of 'Expected Amount with tax' of 
associated PLIs. 

• Mapped triApprovalamountNU. 

(Tri-68112-IJ26741) 

Facilities Projects In a Program record, for each Funding Request created for the Facilities 
Project type, the "Total Funding" column is computed and displayed in the 
Projects section in the Program record. The Total Fund field is also displayed 
in the Facility Project record > Facilities Project Request > General > Summary 
section. (Tri-88291-IJ37826) 

Facility Projects In a Program record, for each Funding Request that is created for the Facility 
Project type, the "Total Funding" column is computed and displayed under the 
Project section. The total fund is also displayed in the Facility Project record > 
General tab > Summary section. 

In Facility Project, a new "Funding Allocations" section is added in the Budget 
tab. This section displays the funds that are allocated to the Facility Project. 
You can perform the following actions in the Funding Allocation section: 

1. Add Funding Allocations: use this action to add funds to the Facility 
Project. 
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Area of Change Description 

2. Transfer Funds: use this action to transfer funds from the Facility 
Project. 

(Tri-88298) 

Geography If the name on the Geography record changes, on the Save action, the system 
will update the new name on all descendent geographies. Also, on the 
Geography record, the Reporting section will update the parent fields as per 
the new name. The new name will also be updated on all the buildings that are 
associated with the updated geography. (Tri-85126) 

Geography If you cut a Geography record and paste it under another Geography record, 
the correct parent data will be mapped to the Geography record.  

(Tri-87724-IJ44371) 

Job Plans When users navigate to the Maintenance Landing page, they will be able to 
view the Job Plans created by them and associated with their organization in 
the 'My Draft Job Plans' and 'My Active Job Plans' portal sections.  
(Tri-88281-IJ34971) 

Key Management When you create a Key Request under Facilities request, on Copy action of the 
Key Request, a Key Request record is created instead of a Service Request 
record. (Tri 85051-IJ43455) 

Lease - Asset and Real 
Estate 

While performing 'Non-Lease-Accounting Amendment', the user actions will be 
limited. 

• Cannot generate/remove/update payment schedules with the 
Summary Type 'Rent' and 'Include In Amortization' or 'Include In Rental 
Prepayment' set to TRUE, or with the Summary Type 'Incentive' and 
'Include In Upfront Incentive' set to TRUE. 

• Can update payment instructions for any payment schedule. 

• Can update the following sections on Options: Document Reference, 
Comments, Notify Roles, Notify Within. 

• Can exercise reasonably certain options (i.e. already set as likely term 
option). 

• Cannot set an option as Likely Term and exercise any option which is 
not reasonably certain (i.e. likely term). 

• Can Add/Remove/Update any non-index clause. 

• Can update any sections on Index Clause, except Index Adjustments, 
Payment Schedule, Options. 

• Cannot add/remove/update the Premise Locations section on the 
Locations tab for RE Lease and Leased Assets section on the Assets tab 
for Asset Lease.   

(Tri-76796-IJ30783) 

Lease - Asset and Real 
Estate 

The answers to the ownership questions on the Local Reporting tab are now 
updated based on the answers sets for the same questions on the Accounting 
tab. (ASC 842 or IFRS 16). (Tri-68390) 

Lease - Asset and Real 
Estate 

The Ownership and Purchase Option questions on the Local Reporting tab are 
no longer linked to questions under IFRS/FASB Treatment section. (Tri-68392) 
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Area of Change Description 

Lease - Asset and Real 
Estate 

Fields for ‘Short Term Lease’ and ‘Include In Amortization’ are added to the 
Local Reporting tab. This is to differentiate GAAP and IFRS in the case GAAP is 
still short term, but IFRS is not. 

A new straight-line schedule is visible if the lease is a short-term lease and 
Include In Amortization is not selected. The schedule is also available on the 
Local Reporting tab. 

Reassessment of Short Term lease after Modification: 
GAAP (FASB): For a Short Term lease, when there is a change in lease terms 
either by an Option or by changing the Accounting End Date, if the remaining 
lease term extends for more than 12 months from the end of the previously-
determined lease term, the lease will not qualify as Short Term Lease. 
IFRS (IASB): For a Short Term lease, on reassessment, if the likely term is more 
than 12 months, the lease will not qualify as Short Term Lease. 

When there is a modification and the lease is no longer a short-term lease, the 
transition/adjustments of IDC, Prepayment, and Accrued Liability will be 
included in the Operating/Finance schedule. (Tri-67893-IJ25706) 

Lease - Asset and Real 
Estate 

On the Accounting and Local Reporting tabs, the GAAP Classification question, 
“Is it reasonably certain at commencement date that the purchase option will 
be exercised at the end of the lease?” is set to be read-only. 

On the Initial lease, the answer to this question is set to 'Yes' if there is a likely 
purchase option. 

For both GAAP and IFRS leases, the classification question, "Does property 
transfer ownership at the end of the lease?" will be set to 'Yes' if there is a 
likely purchase option. 

IFRS Classification section is now labeled as 'Other Information'. (Tri-68394) 

Lease - Asset and Real 
Estate 

The Lease Classification question, 'Does Property Transfer Ownership at the 
end of the lease?' is now visible for IFRS Leases. If it is set to 'Yes', the lease is 
no longer short term. (Tri-68429) 

Lease - Asset and Real 
Estate 

Calculations of leases for less than a month are modified, and the Asset value 
is coming down to zero for both Operating and Finance schedules.  
(TRI-67089-IJ25249) 

Lease - Asset and Real 
Estate 

The Include In Amortization Schedule checkbox will be set to read-only after a 
short-term lease is modified. (Tri-68459) 

Lease - Asset and Real 
Estate 

A lease still qualifies as short term if likely term<=12 months and initially, it 
was short term=Yes. (Tri-68206) 

Lease - Asset and Real 
Estate 

When a user performs a non-lease accounting amendment type revision, the 
Payment Schedules of Rent and Tenant Improvement Incentive types cannot be 
voided. (Tri-88289-IJ37263) 

Lease - Asset and Real 
Estate 

On making non-lease-accounting amendments, the section actions in the 
Payment Schedules section of clauses are not hidden and allow to Find or 
Generate Payment Schedules except for the following type of payment 
schedules: 
1. Payment Schedules with the Summary Type 'Rent' and 'Include In 
Amortization' or 'Include In Rental Prepayment' set to TRUE. 
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Area of Change Description 

2. Payment Schedules with the Summary Type 'Incentive' and 'Include In 
Upfront Incentive' set to TRUE. 

(Tri-77602-IJ35915) 

Lease - Asset and Real 
Estate 

The Accounting and Clauses, Options & Terms tabs are set to read-only after 
you go to Contract Revise > Non-Lease-Accounting Amendment, and then click 
Cancel. (Tri-76794) 

Lease - Asset and Real 
Estate 

For Asset Leases, whenever a modification is done, the Modification History 
section on the History tab displays the records. (Tri-88760) 

Lease - Asset and Real 
Estate 

The History tab of a Real Estate and Asset Lease displays the Created Time of 
the Current and Previous Amendments. (Tri-88300-IJ41672) 

Lease - Asset and Real 
Estate 

When users remove the scheduled status Payment Schedule, the associated 
payment Instruction will not get retired if that Payment Instruction has any 
Pending status Payment Schedule associated to it. (Tri-88301-IJ44216) 

Lease - Asset and Real 
Estate 

For a Payment Schedule record with Partial Payments, the Expected Date field 
in the Partial First and Partial Last Payment sections is editable and can be 
updated by a user. The updated value entered by a user will be retained even 
if the Payment Schedule record is closed and reopened. (Tri-88302-IJ44341) 

Lease - Asset and Real 
Estate 

For an IFRS lease, in the Finance Schedule section, the '(Gain) Loss on 
Revaluation' column is now populated with Gain when the IFRS Reversal 
Impairment is performed. The gain is the IFRS Reversal Impairment Amount 
Allowed. (Tri-71526) 

Lease - Asset and Real 
Estate 

The Net Equity for the IFRS reversal impairment period is now calculated 
correctly (Net Asset - Liability). (Tri-71605) 

Lease - Asset and Real 
Estate 

On clearing the likely term option from the Lease > Accounting tab > Term 
Option section, the Accounting End Date is updated and mapped from the 
latest history lease without a likely term option associated with the lease. 
(Tri-68457) 

Lease - Asset and Real 
Estate 

On an Operating lease, when you perform a modification after the lease is 
impaired, the Accrued Liability now comes down to 0. (Tri-82528) 

Lease - Asset and Real 
Estate 

When a lease is amended after Accounting revise > Data Revise, all the 
required sections are editable. (Tri-88278-IJ34262) 

Lease - Asset and Real 
Estate 

If an approval request has been returned and then resubmitted, the “Only re-
reviewed by who returned and subsequent reviewers” action routes the 
approval to the reviewer who returned it. However, If the reviewer who 
returned the approval is no longer associated to the record for that role then 
approval will route to the person who is currently assigned. Once approved by 
that approver, the approval routing resumes with the next reviewer. 
(Tri-88745-IJ44946) 

Lease - Asset and Real 
Estate 

When abandonment is performed, RVG, IDC, and IBR fields are read-only and 
the Calculate NPV action is hidden. (Tri-88630) 
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Area of Change Description 

Lease - Asset and Real 
Estate 

After adjusting the payment schedules, the partial payment line items and 
catchup payment line items are generated correctly. (Tri-88262- IJ29039) 

Lease - Asset and Real 
Estate 

When a Business Unit contains an apostrophe (') or a single quote (' ') in its 
name, all disclosure BIRT reports generate correct result. (Tri-83373-IJ41509) 

Lease - Asset and Real 
Estate 

When a lease is terminated in the middle of the month by using Prorated 
Payment Option, then the Amounts on Payment Line Item and Fiscal Line Item 
are calculated correctly. (Tri-88283-IJ35042) 

Lease - Asset and Real 
Estate 

After modification, the Fiscal Line Items are calculated correctly for leases 
that have a start date as 30th or 31st. (Tri-88284-IJ35507) 

Lease - Asset and Real 
Estate 

Multiple contract attributes might be erroneously associated with a lease 
record. The extra contract attribute records will be deleted from the leases 
when the PatchHelper workflow, triPatchHelper - triCalculate - 10.X Gemini - 
Remove Additional Contract Attribute, is run. Only one contract attribute must 
be associated with the lease. The leases that have the status of Active, 
Revision In Progress, Revision Accounting In Review, Review In Progress, 
Routing In Progress, Terminated, Expired, and Retired will be included. 
 
Note: 

1. This PatchHelper workflow might take a long time to run. If you 
choose to filter for a set of leases, the query is “triContract - 
Workflow - All Real Estate And Asset Leases Exclude History and 
Upload Error”. 

2. Before triggering this PatchHelper workflow, you must inform the 
users that they must not revise their leases or make any other changes 
to their existing leases until the updates are completed.  

(Tri-88268-IJ30243) 

Lease - Asset and Real 
Estate 

The gain or loss calculated is now included in the Total Rent Expenses in the 
Schedule Summary section. 
 
Note: The Total Rent Expenses field in the Schedule Summary section of the 
Accounting tab and the Amortization Schedule section of the Local Reporting 
tab will now get calculated or updated after the accounting schedule gets 
generated or recalculated. It will no longer get calculated or updated along 
with the NPV. (Tri- 87969) 

Lease - Asset and Real 
Estate 

When the Journal Entry period is set to the Accounting start or any date fields, 
it does not cause performance issue and calculations are correct for the 
period. (Tri-88285) 

Lease - Asset and Real 
Estate 

When a lease is terminated, the penalty amount is displayed under the Lease 
Schedule Summary section. Journal Entry templates are set up pointing to the 
penalty amount. (Tri-67762-IJ26208) 

Lease - Asset and Real 
Estate 

During the modification of a lease, on the Contract Revision form, users will 
not be able to select any fiscal period that is prior to the Accounting Start Date 
or after the Accounting End Date. (Tri-88265-IJ30333) 
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Area of Change Description 

Lease - Asset and Real 
Estate 

While modifying a Real Estate lease with a reduction in Square feet or Space, 
the IFRS schedule on the Local tab or the Accounting tab includes a reduced 
ROU Asset value based on the proportion of Square feet reduced. 

While modifying an Asset lease with a reduction in the number of Assets, the 
IFRS schedule on the Local tab or the Accounting tab includes a reduced ROU 
Asset value based on the proportion of Assets reduced. (Tri-82273-IJ29335) 

Lease - Asset and Real 
Estate 

Resolved the issue of Liability calculations for the 'Reclass Current to Long 
Term Liability' Journal Entry. (Tri-67760-IJ26204) 

Lease - Asset and Real 
Estate 

When a lease is terminated at the end of the month or terminated partially, 
Gain/Loss and Accumulated Gain/Loss is populated in Accounting Schedules. 
(Tri-88288-IJ40017) 

Lease - Asset and Real 
Estate 

While modifying a lease with a reduction in term, the IFRS schedule on the 
Local tab or the Accounting tab includes a reduced ROU Asset value based on 
the proportion of the number of periods reduced. It is applicable for both Asset 
and Real Estate Lease. (Tri-82271-IJ25051) 

Lease - Asset and Real 
Estate 

While using out-of-the-box JE Setup Templates, on Lease Expiration, the 
accounts for Liability, ROU Asset, and Accumulated Amortization are closed 
down to zero. (Tri-82269-IJ25049) 

Lease - Asset and Real 
Estate 

An abandonment is now available. An accountant can perform an abandonment 
on a lease by going to Accounting Revise > Contractual Factors. The 
Abandonment checkbox will be available, and the Abandonment Date 
(Decommission Date) must be entered to accelerated amortized the asset to 
the Abandonment Date. 

The Decommission Date in the Schedule Summary section will be populated 
with the Abandonment Date. Also, the Remaining Useful Life field will be 
calculated from the Modification Effective Date to the Decommission Date. 

The lease will be recalculated like a Finance lease and the asset will be 
amortized straight lining up to the Decommission period. For an Operating 
lease, the Rent Expense is no longer straight-line. The lease will continue to be 
calculated like a Finance lease for any subsequence modifications.  
(Tri-79264-IJ31113) 

Lease - Asset and Real 
Estate 

A new 'Alternative Period' field is added to the Lease Journal Entry Calculation 
Period form. 

The Fiscal Period (of lease) from the Alternative Period is used in the Journal 
Entry calculations if there is no Fiscal Period for the selected Calculation 
Period or Cumulative From Period. (Tri-82270) 

Lease - Asset and Real 
Estate 

While issuing an index adjustment on a clause that has minimum percent, the 
Expected Amount on Payment Line Items is calculated correctly. 
(Tri-88296-IJ41203) 

Lease - Asset and Real 
Estate 

While recording AR Receipts, the precision of the value of the sum amount 
under the Expected Amount column and under the Delta Amount column is now 
the same. AR Receipts Delta Amount computation is now up to a precision of 
two decimal places. (Tri-88264-IJ29395) 
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Area of Change Description 

Lease - Asset and Real 
Estate 

Activate action will be hidden from the Contract Administrator when the Lease 
Accountant returns the lease after submitting it for Revision Accounting In 
Review. (Tri-88286-IJ36880) 

Lease - Asset and Real 
Estate 

When the Rent Component Assumption section is updated for Contractual 
Factors, Journal Entries are generated. (Tri-88295-IJ40690) 

Lease - Asset and Real 
Estate 

Resolved an issue where the Journal Entry period did not populate correctly 
when the accounting start date was set to a later date. (Tri-83129-IJ41306) 

Lease - Asset and Real 
Estate 

For the Lease Impairment scenarios, now the Recalculate NPV action is not 
available in the GAAP Classification section on the Lease Accounting tab.  
(Tri-90045) 

Lease - Asset and Real 
Estate 

The calculation for Interest Reduction on the accounting schedule is now 
computed correctly for a lease that has a lease incentive. (Tri-88256-IJ25104) 

Lease - Asset and Real 
Estate 

While using out-of-the-box JE Setup Templates, on Lease Termination, the 
accounts for Liability, ROU Asset, and Accumulated Amortization are closed 
down to zero. (Tri-82268-IJ25046) 

Lease - Asset and Real 
Estate 

When a Lease is terminated before the current open period, reversal Journal 
Entry templates are created. (Tri-77315-IJ35295) 

Lease - Asset and Real 
Estate 

When an asset is reduced to 0 and again extended, the asset value will come 
down to 0. The Gain/Loss from the previous modification gets deducted from 
the net asset value; a Journal Entry gets created for this deducted amount. 
(Tri-82280-IJ25723) 

Lease - Asset and Real 
Estate 

Segment Value Errors on Journal Entry Creation is now fixed for Department 
Accounting Cost Center and Division Accounting Cost Center.  
(Tri-67177-IJ25603) 

Lease - Asset and Real 
Estate 

The gain or loss amount generated on partial termination is added to the 
accrued Liability column. This fixes accounting schedules calculation issue on 
multiple partial terminations. (Tri-82276-IJ28880) 

Lease - Asset and Real 
Estate 

On Non-Lease Accounting Amendment, for Rent and Incentive Payments, the 
non-accounting fields can be updated while performing the payment 
adjustment. (Tri-76795-IJ32747) 

Lease - Asset and Real 
Estate 

Formulas for the following three columns are updated from the Operating or 
Finance schedule: 

1. Liability Value is calculated by doing the sum of Current Period Change 
in Liability and Previous Period Liability Value. 

2. Long-Term Liability is calculated by Short Term Liability, Liability 
Value, and Accrued Interest Balance. 

3. Change in Liability is calculated from the Interest Expense, Interest 
Reduction, and Principal Reduction.  

(Tri-87735-IJ44436) 

Lease - Asset and Real 
Estate 

For IFRS reduction in a term, when an option exists on the lease before a 
modification, the following scenarios are considered as reassessment and not a 



 

© Copyright IBM Corporation 2023.  13 

 

Area of Change Description 

modification. Therefore, the gain or loss calculated is no longer populated. 
Also, the asset is adjusted based on the change in liability. 

Scenario 1: A lease has a Termination option with Likely Termination Execute 
before the Likely Term End Date. The option hasn’t yet been reasonably 
certain before a modification. Later, the lease is modified to reasonably 
certain on the Termination option. 
 
Scenario 2: A lease has a Renewal option; the option is reasonably certain 
before a modification. However, the lease is later modified to be not 
reasonably certain on the renewal option. (Tri-82336) 

Lease - Asset and Real 
Estate 

On changing the Process Type, Process Journal Entries now retrieve leases 
correctly. (Tri-88292-IJ39115) 

Lease - Asset and Real 
Estate 

The Contract Revise Screen now opens even when both the Base Lease 
Expiration Date and the Accounting End Date are blank. 
(Tri-67580-IJ26219) 

Lease - Asset and Real 
Estate 

On activation of a lease, now only one email notification will be sent to the 
user. (Tri-88282-IJ35036) 

Lease - Asset and Real 
Estate 

Total Rent Expense includes Initial Direct Costs, Incentives, Exit or Disposal 
Liability Carryover, and Prepayments for both IFRS and GAAP leases. 
(Tri-87734-IJ32117) 

Lease - Asset and Real 
Estate 

Multiple issues of GAAP & IFRS leases for the Negative ROUA scenario are now 
fixed. 

• Scenario 1: Original lease + Full Impairment + perform modification to 
reduce payments [For IFRS leases, Calculations for Gross Asset Value & 
Accumulated Amortization are fixed] 

• Scenario 2: Original lease + Perform modification to make lease 
variable and reduce payments [For both GAAP & IFRS leases, 
Calculations for Gross Asset Value & Accumulated Amortization are 
fixed] 

• Scenario 3: Original lease + Full Impairment + perform modification to 
reduce space [For IFRS leases, Calculations for Gross Asset Value, 
Accumulated Amortization & (Gain) Loss on Revaluation are fixed] 

When the asset is already 0 and the adjustment to the asset at the 
modification no longer reduces the gross asset further and if the adjustment to 
the asset is more than the current asset itself, the gross asset will now be 
adjusted to the current asset amount. Both gross assets and accumulated 
amortization are now calculated correctly. (Tri-82277-IJ31960) 

Lease - Asset and Real 
Estate 

On lease the Accumulated Gain/Loss column in Accounting Schedules will be 
calculated correctly for multiple impairments as well. (Tri-82335) 

Lease - Asset and Real 
Estate 

The Lease Local Reporting utility is designed for the leases where local 
reporting is not enabled upon the initial lease activation, but, at a later point, 
local reporting schedules are required. The utility will create a mirror lease, a 
replica of the original lease. Based on the local reporting look back period set 
on the application settings record, the system might perform local reporting 
standard adoption on the mirror lease. Next, all the modifications performed 
on the original lease of types Amendment, Change In Assessment, and 
Contractual Factors will be applied to the mirror lease in the same sequence. 
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Finally, after all the modifications are updated to the mirror leases and lease 
schedules recalculated, all the details from the lease local reporting tab of the 
mirror lease will copy over to the original lease. For more details, refer to the 
Lease Local Reporting Utility user guide in version 11.1. (Tri-88254-IJ22846) 

Lease - Asset and Real 
Estate 

The NPV will not be recalculated for the IFRS Reversal Impairment and 
Abandonment scenarios. (Tri-89611) 

Lease - Asset and Real 
Estate 

When a lease is terminated and the Due Date of the terminated Payment Line 
Item is after the Termination Effective Date, then the Due Date is updated 
with the Termination Effective Date. (Tri-88280-IJ34801) 

Locations On the Work Task form, under the Resources tab, while adding the location 
type resource record, the two fields, Name and Hierarchy Path, now populate 
correctly from the selected Location record. (Tri-88270-IJ30586) 

Locations Floor Common type spaces will get prorated out if the floor is a 100% common 
floor. In such cases, the floor common area will be added to the building 
common area and get prorated. (Tri-IJ28585-68767) 

Locations Building System Items records will get retired and removed from the Building 
System Items section in the Location records when the corresponding Location 
record is Retired. 

Patch will retire all the existing Building System Items records that are not in 
the retired state but associated with the retired building records. 
(Tri 87726-IJ45014). 

Move Requests If you encounter any issue while submitting the move request, a user message 
is displayed in the Attention section of the Move Request form. On revising any 
request, such as service request, move request, inspection request, and so on, 
if there is no request class associated with the building for which the request is 
raised, the system automatically associates all the request classes based on 
the request type. 

For example: If a move request is raised, then on revising it, if there is no 
request class associated with the building for which the request is raised, the 
system will automatically associate all the request classes (small move, group 
move, individual move). (Tri-67010-IJ25752). 

Move Requests On completion of the last work task of a facility project for a move request, 
the Facility Project will be completed as all the work tasks and related MLIs 
and requests are completed. The attention message will no longer be 
displayed. (Tri-87727-IJ44495) 

Move Requests 
Performance 

The performance of the Group Move Perspective application in handling the 
large data sets for the item details page has significantly improved. The user 
experience is now more responsive. The following change is worth mentioning: 
Now a loading indicator is displayed next to the total line item count while 
adding or removing line items. (Tri-67722-IJ26083) 

Move Requests 
Performance 

The performance of the Group Move Perspective application in handling large 
data sets for the Search page has significantly improved. The user experience 
is now more responsive than before. The following are some of changes worth 
mentioning: 
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• A loading indicator is now displayed next to the total line item count 
while adding or removing line items. 

• For search page and item details page, sorting is now applied to the 
asset, equipment, and room line items.  

(Tri-67720-IJ26084) 

Microsoft Graph API While changing EWS API to Graph API, certain additional attributes must be 
passed for the Graph API that were not required with EWS. These changes add 
mappings for those additional requirements. (Tri-88351) 

Object Migration The My Profile record of an employee will now be retired when the Employee 
is retired. The user will no longer be able to log in when the record is in the 
retired state. (Tri-87921-IJ36995) 

Organizations The system will identify duplicate "Contact Role" associated with any record 
based on the Name and ID of the selected Contact and the Name of the 
selected Role. If the preceding parameters match with the newly created 
parameters, the system will display a warning message and will not allow you 
to save the Contact Role. (Tri-88269-IJ30384) 

People Active People Records will be displayed in the Home > Tasks > Manage 
Resources > “My Team's Labor Details” and “My Team's Licenses and 
Certifications” portal sections. 

Also, the system now correctly displays Licenses and Certifications associated 
to specific people records. (Tri-67382-IJ25969) 

People Now the system will display a user message for password change as per the 
selected 'Optional Rule Requirements' in Tools > System Setup >System > 
Password Setup. (Tri-88259-IJ27359) 

People 
Licensing 

Resolved an issue where the groups or licenses are out of sync when they are 
modified before a newly created user logs in for the first time. (Tri-87925) 

Primary Location and 
Asset Allocation 

If you change the name on the location record and click Save, the system will 
update the name on all the associated records. For example, primary work 
location field of the Work Task records and primary location field of the Asset 
records. (Tri-88272-IJ30897) 

Projects For the Facility Project type, the "Budget" and "Actuals" columns in the Project 
section of the Program record are computed and the values are displayed. 
These field values are computed from the Accounting section of the Budget tab 
in the Facility Project. (Tri-88299-IJ41960) 

Report Scheduler In a report scheduler record, while setting up recurrence pattern type for the 
scheduler, all the recurrences are working as designed. The show and hide 
feature for Daily, Weekly, Monthly, and Yearly options is now working correctly 
based on the selected recurrence pattern. (Tri-87728-IJ43993) 

Requests On a Service Request record raised for a specific building, you are allowed to 
select any floor that is associated with the selected building. You can try 
mapping different floors multiple times without clearing the existing floor from 
the field. (Tri-88294-IJ39947) 
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Requests Under General tab > Duplicate Search, the new "Associate Additional Asset & 
Location?" check box is added to the Request Class form. If this check box is 
selected, all the additional locations/assets can be associated with the work 
tasks. This scenario is applicable only when the assignment rule in the Service 
Plan is "Create single work task for all asset/location" and the Duplicate Search 
option in the request class is set to "Auto-Assign to Duplicate".  
(Tri-88276-IJ32956) 

Reserve The system will display the Reservation Instance records in tabular format 
whenever users try to drill down through the data point of the metric report 
"triReservationResourceDayFact - Metric - Room Utilization Metric". The issue 
occurs when users use "Calendar Day" as the Show by Filter. A new query 
report is placed at the data point that will now render all the Reservation 
Instance records. (Tri-88275-IJ33202) 

Reserve Purchase orders are generated for all the food orders. (Tri-88357-IJ35117) 

Reserve The Concierge form now calculates the End Date correctly after the form is 
reset. (Tri-88368-IJ24406) 

Reserve The system will now map the Reservation ID and the correct End Time to the 
notification when a resource gets declined. (Tri-88362) 

Reserve The system will not block the Room/Space added to the Resource Downtime 
Record if the Resource Downtime Record is in the Draft state. In such a 
scenario, the Space records associated with the Resource Downtime record will 
be available for reservations. (Tri-88398-IJ34746) 

Reserve Users will not be able to Accept or Reject the cancelled room via old Microsoft 
Outlook email notifications. Also, now the Resource Owner will receive an 
email notification whenever the Room Resource (Requestable) that is pending 
for approval has been cancelled stating to Ignore the previous approval email 
(Tri-88352-IJ31157). 

Reserve The system will now be able to cancel and update reservation occurrences by 
importing the .ics file into Microsoft Outlook for the reservation record that is 
created, updated, or cancelled by using the foundation TRIRIGA Application or 
the Reserve Perceptive App. (Tri-88360-IJ29842) 

Reserve For a Recurrence meeting, reservations were set up initially with attendees 
without adding a room. The system is now able to handle the updates done to 
the individual occurrences while making reservation modifications. Therefore, 
for such recurrence reservations, users can now update the room details later 
for individual meeting occurrences. (Tri-88358-IJ35305) 

Reserve On modifying an existing 'Recurring' type reservation where the status of some 
of the reservation instances is completed, the system will successfully create 
and update the future reservation instances; and the updated reservations will 
also be considered in the Downtime Search. (Tri-88287-IJ37165) 

Reserve If a reservation is created in Microsoft Outlook and the Subject field is left 
blank, the user will now be able to update the reservation by adding 
Equipment and Food order to that particular reservation by using the Reserve 
Perceptive App. (Tri-88356-IJ29365) 



 

© Copyright IBM Corporation 2023.  17 

 

Area of Change Description 

Reserve Resolved the timing issue that occurred when new reservations were edited 
immediately after creating them. (Tri-88365) 

Reserve The system will now bypass the approval flow on a declined reservation only if 
there is no change other than the subject of the reservation. 
(Tri-88409-IJ30155) 

Reserve The system will now send an email notification to Microsoft Outlook with a .ics 
file attached when a standalone reservation is canceled in the Reserve 
Perceptive App. (Tri-82120-IJ29717) 

Reserve On the Reservation Calendar record, while adding the Available Resource 
record from the Working Hours section, the two fields, Start Date and End 
Date, being relative fields will always display the date and time in UTC format. 
The time issue is now resolved, and it is converted and displayed correctly in 
UTC format based on the Start date or Time entered in the Recurrence record. 
(Tri-88401-IJ33039) 

Reserve The system does not send auto-cancellation email notifications for the room 
resources that are already declined. (Tri-88366) 

Reserve The system will populate the reason in the Rejection Notification whenever 
the Reservation Resource Record is Rejected by Resource Owner.  
(Tri-88402-IJ30927) 

Reserve Reservations created via Outlook with multiple rooms added will create a 
single entry of reservation definition record in the foundation TRIRIGA 
application. Any updates to this Reservation via Outlook will correctly reflect 
in the foundation TRIRIGA application. (Tri-88413-IJ30025) 

Reserve The system will now no longer create multiple reservation definition records 
for one reservation that has multiple rooms. (Tri-88404-IJ29303) 

Reserve Resolved an issue where if you reserved a meeting in Exchange and cancelled 
it immediately after booking, the reservation was cancelled in Exchange but 
not in Reserve. (Tri-88406-IJ29822) 

Reserve The system with active Reservation Policy records will follow the policy 
criteria that include time, people, and room while creating or updating the 
reservation records. Any reservation that does not comply with the Reservation 
Policy criteria is declined. (Tri-88414) 

Reserve On updating the Resource Downtime record, the respective start and end dates 
are now reflected in the associated offline resources/space records.  
(Tri-88397-IJ35272) 

Reserve The Reserve Perceptive App now shows an alternate layout image when the 
alternate layout is selected. (Tri-88486-IJ32918) 

Reserve The End Date field in the Reservation Manager record is now updated correctly 
after performing Early End or Check-Out. (Tri-88363-IJ24451) 
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Reserve In the Reservation Auto Cancellation process, the system will trigger a 
confirmation notification and trigger the required auto-cancel email to the end 
user. (Tri-88367-IJ35173) 

Reserve A new room will be added to all the occurrences in the series except for the 
occurrence in which timings are edited before adding the new room.  
(Tri-88411-IJ30699) 

Reserve For a new reservation record, if something goes wrong while Reserve 
communicates with the Exchange server resulting into a failed reservation, the 
application marks this particular reservation for a "Retry", that is, the system 
will again try to recreate the reservation based on the "Exchange Retry 
Duration" that is scheduled on the Application Settings record > Reservation 
Settings tab. By the scheduled date and time, if the reservation and Exchange 
get the correct settings that are required, the reservation will be created 
successfully. In a failed attempt, the system will again push this reservation 
for a "Retry". Earlier, such multiple retry events were triggered infinitely in the 
system, making the system inefficient and slow without the organizer being 
aware of the issue. 

To address the issue, a number field, “Retry Attempts”, is added 
to Application Settings record > Reservation Settings tab. In the field, 
maximum limit of the Retry Attempts to be scheduled for a particular 
reservation can be specified. By default, it is set to three (3) Retry Attempts. 
If the total Retry Attempts for a specific reservation reaches the Retry 
Attempts specified, the system will send a notification to the reservation 
organizer with the information about what is wrong with the reservation and 
also no retry attempts will be scheduled for this reservation. (Tri-88354) 

Reserve Perceptive App Fixed an issue on iPhone when swiping right, the VoiceOver feature loops on 
the details of the first reservation where there are multiple reservations in a 
month. It now moves on and announces the next reservations.  
(Tri-88489-IJ36448) 

Reserve Perceptive App When you search for a building in the Room Reservation app, VoiceOver for iOS 
devices will now read the building name and the second line of the address 
(including city, state, and country) all together. This also applies to the 
building name and address on the new page (right before you click on search). 
(Tri-88535-IJ36543) 

Security The UserName column is now removed from specific pages of the application 
UI to avoid brute force attacks. (Tri-88267-IJ32427) 

Space Allocation On the Allocation tab of a space record, the related reports in the Chargeback 
Allocations section now display the removed active records for Space Level 
Allocation. (Tri-88266-IJ29914) 

Tasks While capturing a reading via the Procedure Step of a task, the Reading log will 
be associated with the existing "PM Reading Location/Asset" record of the asset 
that has the same job plan as in the task and the same Reading Class and 
Reading Units as in the Procedure Step. (Tri-88263-IJ29206) 

Tasks After activation of a work task, Procedure Steps will be displayed under the 
Active Task Procedure Steps section. (Tri- 89023) 
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Tasks TRIRIGA allows you to capture two different readings, for example, water 
temperature and oil temperature, by using the same unit of measure (UOM) via 
a single work task. 

A new query section, 'Procedure Steps for Reading', is added to the General tab 
for preventative maintenance (PM) schedules based on the readings. The 
system filters PM schedules based on the selected Procedure Steps for Reading 
records in case PM Schedules have the same Reading Classification and Reading 
UOM. 

The new field "Procedure Step" has been added to the PM Reading 
Location/Asset Form > General Tab > Job Plan section. The system will filter 
PM Reading Location/Asset based on the Procedure Step field in cases where 
PM reading records have the same Reading Class and Reading Units. 

In cases where there are no Procedure Steps for the Reading record, the PM 
schedules are filtered based on Reading Classification and Reading UOM. 
Similarly, the PM Reading Location/Asset record is filtered based on the 
Reading Class and Reading Units. 

For example, there are two reading-based PM schedules, PS1 and PS2, in a 
single job plan, JP1, where both the PM Schedules have Reading Classification 
set to Temperature and Reading UOM set to degrees-Fahrenheit. Under the 
Procedure Steps for Reading query section, PS1 has Oil Temperature selected 
and PS2 has Water Temperature selected. 

Scenario 1: If you want to capture the water temperature reading manually for 
any asset with the help of JP1, then you must select Water Temperature as the 
Procedure Step on the PM Reading Location/Asset record. After the reading log 
record is associated with the PM Reading, PM schedule PS2 will be chosen by 
the system for further task creation, if applicable. 

Scenario 2: If you capture readings for any asset via the Task Procedure Step 
record, for example, a task procedure step named Water Temperature, then 
the reading log created will be associated with that PM Reading Location/Asset 
record that has job plan JP1, reading class of Temperature, reading unit of 
degrees-Fahrenheit, and procedure step of Water Temperature. If the system 
does not find any reading with the procedure step Water Temperature, then 
the system will associate a reading log with that PM Reading Location/Asset 
record where the reading class is Temperature, reading unit is degrees 
Fahrenheit, and Procedure Step is blank/null. (Tri-88273-IJ30787) 

Workplace Services 
Perceptive App 

If the End Early option is executed for a meeting in Microsoft Exchange, the 
reservation record will be updated and will display the shortened time 
correctly. (Tri-88364-IJ33876) 

Work Task On completion of a Work Task, the corresponding Service Request is also 
marked as completed, irrespective of whether the task is associated with the 
Facilities project. (Tri-88293-IJ39610) 

Work Task Perceptive 
App 

Filtering issue is resolved by pagination. Now large data is filtered, and 50 
records are loaded at a time. Apart from this, no additional unfiltered data is 
rendered now. (Tri-78893-IJ36478) 

Work Task Perceptive 
App 

The In progress, Completed, and Draft tabs are now paginated. After adding 
pagination to all the tabs, the page is no longer unresponsive.  
(Tri-77892-IJ36486) 
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Workflow Closing and reopening any type of asset record under Portfolio > Assets will not 
show a warning message in a workflow instance if the value of the Workflow 
Name field in the Dynamic Workflow (triShowHideDynWorkflowTX) is blank. 
(Tri-88274-IJ31892) 

Workflow While capturing reading via the Procedure Step of a task, the Reading Log will 
be associated to the existing ‘PM Reading Location/Asset’ record of the asset, 
where Reading Class and Reading Units are same as in the Procedure Step. 
(Tri-88258-IJ27828) 
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Related Documentation 
The IBM TRIRIGA documentation is at https://www.ibm.com/docs/en/tririga and the IBM TRIRIGA 
Application Platform documentation is at https://www.ibm.com/docs/en/tap. The documentation is 
available online in topics or as downloadable PDF files. 

Additional documentation, previously available in the IBM TRIRIGA wiki, is available on IBM TRIRIGA 
Application Platform 3.8. For more information, see the IBM TRIRIGA Release Information page on IBM 
Support. 

 

Support 
IBM Software Support provides assistance with product defects, answering FAQs, and performing rediscovery. 
View the IBM Software Support site at www.ibm.com/support. 

 

https://www.ibm.com/docs/en/tririga
https://www.ibm.com/docs/en/tap
https://www.ibm.com/docs/en/tap/3.8?topic=additional-documentation
https://www.ibm.com/docs/en/tap/3.8?topic=additional-documentation
https://www.ibm.com/support/pages/node/1284928
http://www.ibm.com/support
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Notices 
This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in other countries. Consult 
your local IBM representative for information on the products and services currently available in your area. 
Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, program, or service that 
does not infringe any IBM intellectual property right may be used instead. However, it is the user's 
responsibility to evaluate and verify the operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter described in this document. 
The furnishing of this document does not grant you any license to these patents. You can send license 
inquiries, in writing, to: 

IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A. 

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual 
Property Department in your country or send inquiries, in writing, to: 

Intellectual Property Licensing 

Legal and Intellectual Property Law 

IBM Japan, Ltd. 

19-21, Nihonbashi-Hakozakicho, Chuo-ku 

Tokyo 103-8510, Japan 

The following paragraph does not apply to the United Kingdom or any other country where such provisions 
are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY 
OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow 
disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply 
to you.  

This information could include technical inaccuracies or typographical errors. Changes are periodically made 
to the information herein; these changes will be incorporated in new editions of the publication. IBM may 
make improvements and/or changes in the product(s) and/or the program(s) described in this publication at 
any time without notice. 

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any 
manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the 
materials for this IBM product and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes appropriate without 
incurring any obligation to you. 

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the 
exchange of information between independently created programs and other programs (including this one) 
and (ii) the mutual use of the information which has been exchanged, should contact:  

IBM Corporation 
2Z4A/101 
11400 Burnet Road 
Austin, TX 78758 
U.S.A. 
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Such information may be available, subject to appropriate terms and conditions, including in some cases, 
payment of a fee.  

The licensed program described in this document and all licensed material available for it are provided by 
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any 
equivalent agreement between us. 

Information concerning non-IBM products was obtained from the suppliers of those products, their published 
announcements or other publicly available sources. IBM has not tested those products and cannot confirm 
the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on 
the capabilities of non-IBM products should be addressed to the suppliers of those products. 

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, 
and represent goals and objectives only. 

This information contains examples of data and reports used in daily business operations. To illustrate them 
as completely as possible, the examples include the names of individuals, companies, brands, and products. 
All of these names are fictitious and any similarity to the names and addresses used by an actual business 
enterprise is entirely coincidental. 

Privacy Policy Considerations 
IBM Software products, including software as service solutions, (“Software Offerings”) may use cookies or 
other technologies to collect product usage information, to help improve the end user experience, to tailor 
interactions with the end user or for other purposes. In many cases no personally identifiable information is 
collected by the Software Offerings. Some of our Software Offerings can help enable you to collect 
personally identifiable information. If this Software Offering uses cookies to collect personally identifiable 
information, specific information about this offering’s use of cookies is set forth below. 

This Software Offering does not use cookies or other technologies to collect personally identifiable 
information. 

If the configurations deployed for this Software Offering provide you as customer the ability to collect 
personally identifiable information from end users via cookies and other technologies, you should seek your 
own legal advice about any laws applicable to such data collection, including any requirements for notice 
and consent. 

For more information about the use of various technologies, including cookies, for these purposes, see IBM’s 
Privacy Policy at www.ibm.com/privacy and IBM's Online Privacy Statement at 
http://www.ibm.com/privacy/details/us/en in the section entitled “Cookies, Web Beacons and Other 
Technologies.” 

Trademarks 
IBM, the IBM logo, ibm.com, and TRIRIGA are trademarks or registered trademarks of International Business 
Machines Corp., registered in many jurisdictions worldwide.  

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of 
Adobe Systems Incorporated in the United States, and/or other countries. 

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the 
United States, other countries, or both. 

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its 
affiliates. 

Other product and service names might be trademarks of IBM or other companies. A current list of IBM 
trademarks is available on the Web at “Copyright and trademark information” at 
www.ibm.com/legal/copytrade.shtml.

http://www.ibm.com/privacy
http://www.ibm.com/privacy/details/us/en
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